
Final spine = 0.5625 in

J.P. Terry 
and SmartDoc Technologies

Adobe® LiveCycle®  
Designer
Creating Dynamic PDF and HTML5 Forms  
for Desktop and Mobile Applications

Second edition

Level Beginning through Advanced
Category Business Applications / Digital Publishing
Covers Adobe LiveCycle Designer ES4 and later
Cover Design Aren Straiger

US $54.99 CAn $57.99
ISBN-13:
ISBN-10:

978-0-321-94199-2
0-321-94199-3

9 7 8 0 3 2 1 9 4 1 9 9 2

5 5 4 9 9

Adobe LiveCycle Designer helps you create compelling and dynamic  
documents. The addition of HTML and mobile forms to LiveCycle 
ES4 makes this upgrade a significant breakthrough—it’s the first 
tool to let you develop a form once and deploy it to any device in 
either PDF or HTML5 format. Forms can be used on a wider array 
of devices and in a wider range of software systems than ever before.

In this second edition of Adobe LiveCycle Designer, J.P. Terry brings 
you all new content, including a section dedicated to HTML forms.  
You’ll learn to tackle the challenges of creating intelligent forms 
with critical information in a compact format. J.P. shows how to 
create interactive forms that respond to data entered by the user and  
how to make forms work seamlessly with the database that collects  
customer information. You’ll learn about the technical underpin-
nings of PDF and XFA (Adobe XML Forms Architecture), and 
how LiveCycle generates HTML. You’ll also learn design strategies 
and best practices for developing successful form systems and 
paperless applications. 

This book Covers:

• LiveCycle Designer and LiveCycle Enterprise Suite and how you 
can use them to automate your business

• Why LiveCycle Designer is the best choice for form design
• Creating a Designer form once and deploying it to many devices 

in either PDF or HTML
• Adding power and automation to your forms with simple and 

advanced scripting

“This book is accessible enough for 
a beginner but rich enough for an 
experienced user. It covers all of the 
major topics and includes valuable 
links to other LiveCycle Designer 
documentation and resources.”

—Jeff Stanier, Group Product Manager, 
LiveCycle Designer, Adobe Systems, Inc.

“This book will teach you about  
LiveCycle Designer and show you 
new ways to automate your business  
and improve your brand. J.P. com-
bines his vast knowledge of both 
design and programming to show 
you how to create form systems that  
are effective and simple for everyone.”

— Richard Gerstman, Chairman Emeritus,  
Interbrand U.S.

J.P. TerrY is the Chief executive 

officer and Co-founder of smartDoc 

Technologies. he is a noted expert  

on dynamic document systems and is 

the author of Paperless: Real-World 

Solutions Using Adobe Technology. 

over the past five years, he has taught 

LiveCycle Designer to more than 1,000 

people and brings his experience as  

a classroom teacher to this second 

edition of Adobe LiveCycle Designer.

Adobe Press books are 
published by Peachpit, 
San Francisco, CA 
www.adobepress.com

Adobe® LiveCycle® Designer
Creating Dynamic PDF and HTML5 Forms  
for Desktop and Mobile Applications

SEConD EDition

T
ER

R
Y

 and 
Sm

a
R

T
D

o
c

  
T

Ec
h

n
o

lo
g

iES
A

dobe
® LiveCycle

® D
esigner

C
reating D

ynam
ic PD

F and H
TM

L5 Form
s 

for D
esktop and M

obile A
pplications

S
E

C
o

n
D

 
E

D
itio

n



J.P. Terry 
and SmartDoc Technologies

Adobe® LiveCycle®  
Designer
Creating Dynamic PDF and HTML5 Forms  
for Desktop and Mobile Applications

SECOND EDITION



Adobe® LiveCycle® Designer, Second Edition 
J.P. Terry and SmartDoc Technologies

Adobe Press books are published by Peachpit, a division of Pearson Education.
For the latest on Adobe Press books, go to www.adobepress.com.
To report errors, please send a note to errata@peachpit.com. 
Copyright © 2014 by J.P. Terry

Adobe Press Editor: Victor Gavenda
Project Editor: Nancy Peterson
Development Editor: Robyn G. Thomas
Technical Editors: Adam Jay, Rajesh R. Kandasamy, Yanhui Wang
Copyeditor: Liz Welch
Compositor: Danielle Foster 
Indexer: Karin Arrigoni
Cover Design: Aren Straiger
Interior Design: Charlene Charles-Will, Mimi Heft
Illustrations: J.P. Terry and Elizabeth Hughes

Notice of Rights
All rights reserved. No part of this book may be reproduced or transmitted in any form by any means, elec-
tronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of the pub-
lisher. For information on getting permission for reprints and excerpts, contact permissions@peachpit.com.

Notice of Liability
The information in this book is distributed on an ”As Is” basis, without warranty. While every precaution has 
been taken in the preparation of the book, neither the authors nor the publisher shall have any liability to any 
person or entity with respect to any loss or damage caused or alleged to be caused directly or indirectly by the 
instructions contained in this book or by the computer software and hardware products described in it.

Trademarks
Adobe and LiveCycle are registered trademarks of Adobe Systems Incorporated in the United States and/or other 
countries. All other trademarks are the property of their respective owners. Many of the designations used by 
manufacturers and sellers to distinguish their products are claimed as trademarks. Where those designations 
appear in this book, and Peachpit was aware of a trademark claim, the designations appear as requested by the 
owner of the trademark. All other product names and services identified throughout this book are used in editorial 
fashion only and for the benefit of such companies with no intention of infringement of the trademark. No such 
use, or the use of any trade name, is intended to convey endorsement or other affiliation with this book.

Printed and bound in the United States of America

ISBN 13: 978-0-321-94199-2
ISBN 10: 0-321-94199-3

9 8 7 6 5 4 3 2 1

http://www.adobepress.com


Dedication
To Shannon, Patrick, Rollins,  
and Eva—you make my life dynamic  
and interactive.

To my father, the engineer, and my mother, the teacher— 
this book is a testament to your influence, encouragement,  
and love.

To the incredible SmartDoc Technologies team— 
thank you for all your hard work on this book.

— J.P. Terry



Acknowledgments
I’d like to thank my colleagues at SmartDoc Technologies. You have all con-
tributed greatly to this book, and our team effort has made it complete. A spe-
cial thanks to the core team of Yanhui Wang, Adam Jay, Rajesh R. Kandasamy, 
and Meghan Pipher, who worked many hours on the hands-on exercises. 
Thanks also to Kevin Guterl, Ming Luo, Elizabeth Hughes, Gowthami Sagi, 
Xiaojuan Zhu, Fei Zhong, and Yuling Zhu, who all supported the core team 
with valuable research and reviews.

Thanks to the Adobe LiveCycle Business team, including Dave Welch, Jeff 
Stanier, Vamsi K. Vutukuru, Steve Monroe, Girish Bedekar, and Gary Robbins. 
A special thanks to Jeff Stanier, who has been extremely helpful on both 
editions of this book. Thanks to LiveCycle Engineering, including Rajiv 
Mangla, Suvrat Chaturvedi, Arvind Heda, Raghavendra K. Pandey, Deepak 
Kumar, Kamlesh Bahedia, Saket Sidana, Sudhanshu Singh, Dinesh Pandey, 
and Akshit Jain. A special thanks to Suvrat Chaturvedi and Arvind Heda, 
who have helped me and the SmartDoc team understand the new HTML 
technologies. Thanks to the LiveCycle partner team, including Tony Sanders, 
Bill McCulloch, Howard Zemel, and Lakshmi Anumolu. Thanks also to 
others at Adobe who I have had the pleasure to work with over the past year, 
including Joe Coughlin, Neal Wadhwani, Jason Barnett, Matt Rodgers, Michael 
Jackson, and Mark Johnson. Adobe has developed a great foundation for us to 
build automated desktop and mobile business solutions.

Thanks to Nancy Peterson and the team at Peachpit, including but not limited 
to Robyn Thomas, Damon Hampson, Danielle Foster, Liz Welch, and Scout 
Festa. Their professional efforts and friendship have greatly helped this book.

On a personal note, thanks to my siblings, Kevin, Mary Beth, and Dodd, and 
our extended family and friends for the encouragement you have all given me 
through the years.



About the Author
J.P. Terry is the CEO of SmartDoc Technologies (www.
smartdoctech.com), a leading provider of solutions with 
Adobe LiveCycle and Adobe Experience Manager (AEM) 
document services. SmartDoc has developed paperless 
systems for Fidelity Investments and Merrill Lynch and 
is an Adobe Business Partner. SmartDoc has offices in 
New York; New Jersey; and Beijing, China.

J.P. is an ACI (Adobe Certified Instructor) and an ACE (Adobe Certified Expert) 
in Adobe LiveCycle technology. He often writes and speaks about technology 
solutions for business and is the author of Creating Dynamic Forms with Adobe 
LiveCycle Designer (Adobe Press, 2007) and Paperless: Real-World Solutions 
with Adobe Technology (Adobe Press, 2009).

J.P. is a graduate of the Rhode Island School of Design. He has programming 
certificates from Microsoft and Novell, and a certificate in financial manage-
ment from the Wharton School of the University of Pennsylvania. He has 
recently completed coursework in Java and Android programming at New 
York University. He has participated in international mission trips to build 
housing with local teams and families.

Prior to founding SmartDoc Technologies, J.P. founded BrandWizard Tech-
nologies in 1996. BrandWizard was an early pioneer in MRM (Marketing 
Resource Management) and is now part of the Omnicom Group (OMC). He 
was the CEO of BrandWizard from 2000 to 2005. 

http://www.smartdoctech.com
http://smartdoctech.com


Contents

Introduction x

PART 1 THE DESIGNER TOOL

chapter 1 The Basics 2
Understanding LiveCycle Designer .  .  .  .  .  .  .  3
Working in the Designer Workspace   .  .  .  .  .  .  3

Using the Layout Editor  .   .   .   .   .   .   .   .   .   .   .   4
Using the Script Editor   .  .  .  .  .  .  .  .  .  .  .  5
Using the Left Palettes.  .  .  .  .  .  .  .  .  .  .  .  5
Using the Right Palettes  .  .  .  .  .  .  .  .  .  .  .  7

Understanding Important Designer  
Concepts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  9

Working with Master and Body Pages   .   .   .   .   9
Working with Subforms and Flow  .   .   .   .   .   . 11
Working with Tables.  .  .  .  .  .  .  .  .  .  .  .  . 15
Working with Data   .  .  .  .  .  .  .  .  .  .  .  .  . 18

Customizing Your Environment   .  .  .  .  .  .  .  . 24
Setting Default Fonts   .  .  .  .  .  .  .  .  .  .  .  . 24
Using Style Sheets .  .  .  .  .  .  .  .  .  .  .  .  .  . 26

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 29

chapter 2 Scripting and Advanced Techniques 30
The Benefits of Scripting  .   .   .   .   .   .   .   .   .   .   .   . 31

Using Scripting   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 32
FormCalc and JavaScript   .  .  .  .  .  .  .  .  .  . 33

The Fundamentals .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 37
The Script Editor in Detail .  .  .  .  .  .  .  .  .  . 37
Variables   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 38
Referencing Objects .  .  .  .  .  .  .  .  .  .  .  .  . 41
Events .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 46



Contents vii

Advanced Scripting   .  .  .  .  .  .  .  .  .  .  .  .  .  . 52
Using Script Objects .  .  .  .  .  .  .  .  .  .  .  .  . 52
Using Regular Expressions   .  .  .  .  .  .  .  .  . 60
Using Arrays to Store Data .  .  .  .  .  .  .  .  .  . 61
Handling Exceptions   .  .  .  .  .  .  .  .  .  .  .  . 63
Using the Date Class.  .  .  .  .  .  .  .  .  .  .  .  . 66

Debugging Scripts  .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 68
The Report Palette.  .  .  .  .  .  .  .  .  .  .  .  .  . 68
The Check Script Syntax Tool   .   .   .   .   .   .   .   . 71
Stepping Through Your Scripts   .  .  .  .  .  .  . 72
The JavaScript Debugger   .  .  .  .  .  .  .  .  .  . 73

Tabbing   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 74
How Tabbing Order Works.  .  .  .  .  .  .  .  .  . 75
The Tab Order Palette  .  .  .  .  .  .  .  .  .  .  .  . 75
Options for Tab Order  .  .  .  .  .  .  .  .  .  .  .  . 76

Barcodes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 77
One-Dimensional Barcodes  .  .  .  .  .  .  .  .  . 78
Two-Dimensional Barcodes  .  .  .  .  .  .  .  .  . 78

Web Services .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 80
Connecting to a WSDL File   .  .  .  .  .  .  .  .  . 80
Calling the Web Service  .  .  .  .  .  .  .  .  .  .  . 83

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 84

chapter 3 Creating the SmartDoc Expense Report 85
Creating a Custom Object Library   .  .  .  .  .  .  . 86
Creating the Pages and Subforms.  .  .  .  .  .  .  . 87

Creating the Master Pages .  .  .  .  .  .  .  .  .  . 88
Creating the Body Page and Subforms .  .  .  . 89
Creating a Data Connection .  .  .  .  .  .  .  .  . 91
Previewing a Dynamic Subform .  .  .  .  .  .  . 93

Creating a Dynamic Subform.  .  .  .  .  .  .  .  .  . 94
Creating the Scripts and the Script Object   .  .  . 99

Changing the Button Color   .  .  .  .  .  .  .  .  . 99
Progressive Disclosure.  .  .  .  .  .  .  .  .  .  .  . 99
Calculating Totals .  .  .  .  .  .  .  .  .  .  .  .  .  100
Calculating Totals for Repeating Objects.  .  101
Creating and Referencing Script Objects .  .  102
Referencing Functions in Script Objects  .  .  104

Testing Your Form   .   .   .   .   .   .   .   .   .   .   .   .   .   .   104
Testing Your Form with Data Files .  .  .  .  .  105

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  106



viii Contents 

PART 2 PDF FORMS

chapter 4 PDF and Acrobat 108
The PDF Family   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  109

XFA PDF (PDF Form)   .  .  .  .  .  .  .  .  .  .  .  109
PDF File (Traditional PDF).  .  .  .  .  .  .  .  .  112
Acroforms .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  115
PDF/A .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  116

The Acrobat Family   .  .  .  .  .  .  .  .  .  .  .  .  .  119
Adobe Reader  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   119
Acrobat Standard  .   .   .   .   .   .   .   .   .   .   .   .   .   120
Acrobat Professional.  .  .  .  .  .  .  .  .  .  .  .  120

Understanding Reader Extensions   .   .   .   .   .   .   121
Understanding Adobe Reader  

Limitations   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  121
Extending a PDF Form with Acrobat .  .  .  .  126

Third-Party Viewers   .   .   .   .   .   .   .   .   .   .   .   .   .   129
Viewing PDFs on Tablet Devices .  .  .  .  .  .  129
Web Browsers with Default Viewers  .   .   .   .   129

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  130

chapter 5 Best Practices for PDFs 131
Target Versioning.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  132
Templates and Custom Objects .  .  .  .  .  .  .  .  134

Using Templates.  .  .  .  .  .  .  .  .  .  .  .  .  .  134
Creating Templates   .   .   .   .   .   .   .   .   .   .   .   .   134
Creating Custom Objects   .  .  .  .  .  .  .  .  .  136

Form Fragments  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   138
Fragments at Design Time.  .  .  .  .  .  .  .  .  138
Fragments at Runtime.  .  .  .  .  .  .  .  .  .  .  141

Fonts .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  142
Fonts in Acrobat .  .  .  .  .  .  .  .  .  .  .  .  .  .  143
Fonts in Designer  .   .   .   .   .   .   .   .   .   .   .   .   .   145
Fonts on the Server   .   .   .   .   .   .   .   .   .   .   .   .   147

Localization  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   148
Accessibility  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   150

Viewing Features in an Accessible Form .  .  151
Setting Custom Reader Text  .  .  .  .  .  .  .  .  152

Optimizing Performance .  .  .  .  .  .  .  .  .  .  .  153
Form Strategies  .   .   .   .   .   .   .   .   .   .   .   .   .   .   153
System Strategies   .   .   .   .   .   .   .   .   .   .   .   .   .   159

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  166



Contents ix

PART 3 HTML FORMS

chapter 6 Introduction 168
Previewing Your HTML Forms  .   .   .   .   .   .   .   .   169

Previewing with Designer  .  .  .  .  .  .  .  .  .  169
Previewing with Mobile Forms IVS   .  .  .  .  171

How It Works .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  173
XFA to HTML Transformation .  .  .  .  .  .  .  174
Adobe Supported Browsers   .  .  .  .  .  .  .  .  176

Similarities and Differences   .  .  .  .  .  .  .  .  .  177
Different Host .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  178
Dynamic Flow and Pagination.  .  .  .  .  .  .  179
Layout and Graphics   .  .  .  .  .  .  .  .  .  .  .  180
Patterns .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  181
Scripting and Events.  .  .  .  .  .  .  .  .  .  .  .  183

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  183

chapter 7 Best Practices for HTML Forms 184
Targeting.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  185

Testing with Different Browsers  .   .   .   .   .   .   185
Form Development Strategy .  .  .  .  .  .  .  .  185

Form Graphics  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  187
Form Fragments.  .  .  .  .  .  .  .  .  .  .  .  .  .  187
Tables .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  189
Signatures.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  190

Using Custom Profiles   .   .   .   .   .   .   .   .   .   .   .   .   190
CSS  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   191
Custom Widgets .  .  .  .  .  .  .  .  .  .  .  .  .  .  193

Data Submission .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  194
Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  197

chapter 8 Creating HTML Forms 198
Updating the SmartDoc Expense Report  .   .   .   199

Updating the Font .  .  .  .  .  .  .  .  .  .  .  .  .  199
Editing the XML Source  .  .  .  .  .  .  .  .  .  .  202
Updating the Date Field  .  .  .  .  .  .  .  .  .  .  203
Host Detection and the Change Event  .  .  .  205
Updating the Patterns .  .  .  .  .  .  .  .  .  .  .  206
Updating the Sub Total Calculation  .   .   .   .   207
Updating the Layout.  .  .  .  .  .  .  .  .  .  .  .  208
Dynamic Signature Fields .  .  .  .  .  .  .  .  .  209

Creating the Address Change Form .  .  .  .  .  .  211



x Contents 

Creating the Subforms.  .  .  .  .  .  .  .  .  .  .  211
Creating a Data Connection .  .  .  .  .  .  .  .  217
Creating a Dynamic Subform  .   .   .   .   .   .   .   220
Creating the Scripts and the  

Script Object .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  222
Testing Your Form .  .  .  .  .  .  .  .  .  .  .  .  .  225
Using CSS .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  226
Using Mobile Forms IVS .  .  .  .  .  .  .  .  .  .  227

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  228

PART 4 AUTOMATING BUSINESS

chapter 9 LiveCycle Enterprise Suite 230
Introduction  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

Foundation  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   231
Solution Components  .  .  .  .  .  .  .  .  .  .  .  233
Development Tools   .  .  .  .  .  .  .  .  .  .  .  .  235
Endpoints .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  236

Document Generation  .   .   .   .   .   .   .   .   .   .   .   .   237
The Start Point   .  .  .  .  .  .  .  .  .  .  .  .  .  .  238
Generate PDF Output  .   .   .   .   .   .   .   .   .   .   .   239
Invoke DDX  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  239
Send with Document   .   .   .   .   .   .   .   .   .   .   .   241

Enterprise Form Management   .   .   .   .   .   .   .   .   241
Using Forms Manager .  .  .  .  .  .  .  .  .  .  .  243

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  246

chapter 10 Going Mobile 247
LiveCycle Process Management   .  .  .  .  .  .  .  248

Workspace   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  249
Mobile Workspace .  .  .  .  .  .  .  .  .  .  .  .  .  250

Mobile Strategies .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252
Going Native   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  252
The LiveCycle Advantage   .  .  .  .  .  .  .  .  .  256

Moving On .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  257

 Index 258



Introduction

Did you fill out a form to purchase this book?

If not, are you going to fill out a form to expense it to  
your company?

In the information age, the primary way that we provide  
information to computer systems is through forms. Computers  
can communicate with each other easily. However, when we need  
to provide information to a computer system, we have to fill out  
some type of form (Figure I.1).

Expenses

Yes 10/30/2014 Transportation Airline ticket $455.00

Yes 10/30/2014 Transportation Taxi to airport $20.00

Yes 10/30/2014 Meals Dinner $38.00

$38.00Yes 10/30/2014 Books LiveCycle Designer

Sub Total: 

Less Cash Advance: $.00

           TOTAL $751.00

$751.00

Receipt Date Category Description Cost

X

X

X

X

Yes 10/30/2014 Lodging Hotel $238.00X

ADD EXPENSE

Expense Report
Date Requested:   10/30/2014 

Employee

First Name

J.P.

Last Name

Terry

Client Name

Fidelity

Notes

This was a one day trip to meet with the Fidelity e-Business team 
and National Financial on Summer Street

Sign In

What is your email addess?

My e-mail address is:

No, I am a new customer.

Yes, I have a password:

Do you have an Amazon.com password?

Forgot your password?

Sign in using our secure server

Figure I.1 Some forms that might have been used to purchase this book.



xii IntroduCtIon

Forms are everywhere today. We’re presented with forms when a system or 
an organization wants some type of information from us. For example, the 
government uses forms to ask us for income information for tax purposes; 
youth soccer teams use forms to ask us about our children’s health before the 
start of the season. And with the rise of e-commerce, we’re seeing an increase 
in interactive forms for opening accounts and for purchasing products and 
services. Paper forms and online forms are part of our daily lives in the infor-
mation age.

It’s interesting to note that computers don’t need forms as we think of them. 
Most computer programs require data in much smaller and simpler struc-
tures. The graphic and layout elements in our forms like rules; shapes and 
images are usually disregarded by the computers that process them. For 
instance, in a typical address change, the most pertinent information for the 
computer to know can be contained within a simple and compact file like 
this one:

<addressChange>

 <individual>

  <firstName>James</firstName>

  <lastName>Shannon</lastName>

  <oldAddress>

   <address>1 Main Street</address>

   <city>Springfield</city>

   <state>IL</state>

   <zipCode>62701</zipCode>

  </oldAddress>

  <newAddress>

   <address>101 Main Street</address>

   <city>Springfield</city>

   <state>IL</state>

   <zipCode>62701</zipCode>

  </newAddress>

 </individual>

</addressChange>
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People are the ones who need clearly designed forms (Figure I.2). We need a 
graphically clear presentation of data to understand it and process it. We need 
to comprehend the context of the information exchange. We don’t want to 
simply provide and access data. We want to know why we’re providing data 
and what benefits we’re deriving from our data provision. Forms should be 
designed for us and be human compatible.

Welcome, to a simple Address Change

First Name
J.P.

An Individual

Last Name
Terry

Address
33 Wood Avenue South

City
Iselin

State
NJ

Zip
08830

Who is moving? When?

Old Address:

Email Signature

jp@smartdoctech.com

Approval:

First Name

J.P.

Last Name

Terry

Address

112 West 34th Street

City

New York

State

NY

Zip

10120

New Address:

12/15/2014

Select Individual if you are the only one moving. Repeat this form 
if you receive mail by more than one name. For instance, if you 
also use a maiden name, married name, or nickname.

Submit

Figure I.2 A well-designed form helps users understand the required information and how to supply 
it to complete the transaction.

The trouble is that too many forms are difficult to use and fill out properly. 
According to a survey by Compete Inc., over 70 percent of online account 
opening forms are abandoned before completion. The cost to business in lost 
opportunity and increased customer call center traffic is so substantial that it 
requires us to make a renewed effort to create engaging and effective forms.

If only there were a program with features and tools to help us create engag-
ing and effective forms and link them with data. It would be even better if 
this program were developed and supported by the unquestioned worldwide 
leader in graphics software. Well, your dreams have come true, and it gets 
even better. 
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Adobe LiveCycle Designer, the premier form development tool for the last l0 
years, can now create HTML forms as well as PDF forms. The same LiveCycle 
Designer source files can be used for both. You can create your interactive 
and dynamic fully featured forms and deploy them as HTML forms to mobile 
devices like the Apple iPad and Google Android tablets.

Adobe LiveCycle Designer
LiveCycle Designer (Designer for short) is a Microsoft Windows–based 
program that provides all the tools you need to create basic or sophisticated 
forms. You can use Designer in either of the following ways:

■■ As a standalone program to create forms and documents

■■ As part of Adobe LiveCycle Enterprise Suite (Figure I.3)

LiveCycle Designer

LiveCycle Enterprise Suite

Development Tools

Modules and Services

Foundation

LiveCycle Server

Figure I.3 Designer can be used independently and as part of LiveCycle Enterprise Suite.

LiveCycle Enterprise Suite consists of additional development tools and a Live-
Cycle Server. You’ll learn more about LiveCycle Enterprise Suite in Chapter 
9. When it’s relevant, I’ll mention server tools and features and refer to them 
simply as “LiveCycle Server” to differentiate them from LiveCycle Designer.

However, the focus of this book is Designer. You’ll learn all about Designer’s 
tools and how you can use them to create and manage interactive forms and 
dynamic documents. There are many step-by-step exercises so you can get 
hands-on and learn the best practices for creating PDF and HTML forms. After 
you learn the techniques, the last part of this book will show you how your 
Designer documents are used in the real world to automate business.
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Who This Book Is For
This book is designed for people who want effective and efficient customer 
engagement with their form systems. You may want to create a new form sys-
tem or improve an existing one. In either case, the following types of profes-
sionals will benefit from this book.

Form Developers
Whether you are new to Designer or you’re a seasoned professional, you’ll find 
valuable information and examples in these pages to help you with your craft. 
As you probably know, today’s form developers need to be multi-talented, and 
this book will help you in these areas:

■■ Developing your graphic layout and data pattern skills to meet form 
requirements

■■ Developing new advanced scripting skills for form automation

■■ Understanding how your forms fit into your workflow automation

■■ Understanding the new world of mobile forms

Programmers and IT Professionals
Forms and documents provide the input and output for the computer systems 
you create and manage. Many of your data goals, including validation and 
formatting, can be accomplished with well-designed interactive forms. This 
book will show you how to

■■ Take advantage of Designer’s out-of-the box tools and features to improve 
your systems right away.

■■ Enhance Designer’s standard tools with custom scripting.

■■ Integrate Designer’s forms and documents into your existing enterprise 
systems, including databases, workflow tools, websites, and document 
management systems.
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Business Professionals
Business has changed greatly in the last 20 years. B2C (business-to-consumer) 
and B2B (business-to-business) e-commerce is an increasingly important 
aspect of your job. This book will show you how effective forms and workflow 
automation will help you deliver the following:

■■ Improved customer engagement with your forms and electronic 
communications

■■ Greater conversion of prospects into customers by simplifying the data-
gathering process

■■ Fewer costs and greater speed by converting previously paper-based pro-
cesses to electronic workflows

Part 4 of this book is designed to show how your paperless and mobile goals 
will be achieved. You’ll learn how Designer and other Adobe LiveCycle 
modules will save you time and money while improving the quality of your 
customer communications. You can see a demonstration of these tools on the 
book’s companion site: www.smartdoctech.com/support. You can run this 
demo on your PC, Macintosh, or mobile tablet (Figure I.4).

Interactive Mobile form 
(HTML)

Automatic Document Generation 
(PDF)Interactive Mobile form

(HTML)
Automatic Document

Generation (PDF)

Energy Savers

How we use energy in our homes

Heating accounts for the biggest portion of your 
utility bills. Source: 2010 Buildings Energy Data 

Book, Table 2.1.1 Residential Primary Energy 
Consumption, by Year and Fuel Type.

Let us help make your move easier. The checklist below is 
a breakdown of what you should do each week.

Moving Checklist

8 Weeks Before Your Move

To simplifiy your move, please 
follow the checklist below

Start collecting estimates from moving companies.

Budget for moving expenses. 

Start researching your new community.

7 Weeks Before Your Move

Arrange to have school records transferred

Gather copies of records

Cancel or transfer your club memberships

Change Of Address Summary
We make it easier for you

Change Of Address Summary

12587-54987

Name

Confirmation #

Melissa McHugh

Old Address 714 Longview Avenue

New Address 12 Grimmauld Place

Welcome, to a simple Address Change

First Name
James

An Individual

Last Name
Shannon

Address
1 Main Street

City
Springfield

State
IL

Zip
62701

Who is moving? When?

Old Address:

Email Signature

jp@smartdoctech.com

Approval:

First Name

James.

Last Name

Shannon

Address

101 Main Street

City

Springfield

State

IL

Zip

62701

New Address:

09/20/2014

Select Individual if you are the only one moving. Repeat this form 
if you receive mail by more than one name. For instance, if you 
also use a maiden name, married name, or nickname.

Submit

Figure I.4 The book’s companion site includes a demo of an automated Address Change workflow that includes an 
interactive form and dynamic document generation.

http://www.smartdoctech.com/support
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What This Book Covers
You’ll learn what Designer is, how you can use it to create PDF and HTML 
forms, and why this is important for your organization.

The Designer Tool
Part 1 is a thoroughly updated version of the first edition of this book. As in the 
first edition, this section covers the tools and features of Designer. However, it 
also includes the new features of Designer like style sheets and has additional 
advanced scripting techniques that were not part of the first edition. Part 1 
ends with a comprehensive step-by-step exercise where you can put your new 
knowledge to the test. You’ll create a complete interactive and dynamic form 
from scratch.

PDF Forms
Part 2 focuses specifically on PDF forms, documents, and best practices. You’ll 
learn about the various types of PDFs and the different readers that people 
use to view them. Chapter 4 includes important information about the differ-
ences between Adobe Acrobat and the free Adobe Reader and shows you how 
to Reader extend your files to overcome the limits of the free version. Chapter 
5 covers best practices, including form fragments, localization, accessibility, 
and performance optimization.

HTML Forms
Part 3 covers Designer’s new HTML capabilities and details the similarities 
and differences between Designer’s HTML and PDF forms. You’ll learn how to 
iron out some of the differences so you can develop Designer forms that can 
be used to render whichever form type is needed in your workflow. Like Part 1, 
this part ends with step-by-step exercises where you’ll create interactive and 
dynamic forms. However, this time they’ll be HTML forms.
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Automating Business
The last part of the book shows how your Designer forms and documents will 
be used to automate your business. You’ll learn about Adobe’s other LiveCycle 
tools and modules and how they can be used to manage your forms and 
streamline your workflows. The last chapter of the book covers the new world 
of mobile forms and compares and contrasts different strategies for compet-
ing in this world.

What You Need to Begin
As mentioned, there are many hands-on exercises in this book. Therefore, 
you’ll need the following items to enhance your learning experience.

The Software
You need both LiveCycle Designer and Adobe Acrobat installed on your com-
puter. You’ll develop your forms and documents in Designer and preview them 
with Acrobat. You’ll also need a relatively new web browser to view your forms 
as HTML. Chapter 6 includes a list of supported web browsers.

LiveCycle Designer

You need the Designer program. You may already have it if either of the follow-
ing is true:

■■ Your company has a license for Adobe LiveCycle Enterprise Suite.

■■ You have a version of Adobe Acrobat earlier than 11. Designer shipped with 
earlier versions of Acrobat, but beginning with Acrobat 11, Designer is sold 
as a separate product on the Adobe website. Please note that the versions 
of Designer that shipped with Acrobat prior to Acrobat 11 do not fully sup-
port the HTML capabilities described in this book. If you want to develop 
HTML forms, you must have Designer ES4 (version 11) or later. 

If you don’t have LiveCycle Designer, you can either buy it or download a trial 
version from www.adobe.com. As of this writing, Adobe is offering a 60-day 
free trial at www.adobe.com/products/livecycle/tools/designer.html.

If this link gets changed, simply do a Google search for LiveCycle Designer 
trial download. You’ll need an Adobe ID, and you can select your language 
version prior to downloading (Figure I.5).

http://www.adobe.com
http://www.adobe.com/products/livecycle/tools/designer.html
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Download help

System requirements

1234-1234-1234-1234-1234-1234

Figure I.5 You can download a free trial version of Designer from the Adobe website.

There are various ways to configure your LiveCycle Designer workspace. To 
easily follow the exercises in this book, open the following palettes in your 
Designer workspace. If you don’t see any of the palettes listed, you can open 
them from Designer’s Window menu.

■■ The Script Editor palette

■■ The Hierarchy palette

■■ The Data View palette

■■ The Tab Order palette

■■ The Object and Fragment Library palettes

■■ The Style Catalog palette

■■ The Layout, Border, Object, and Accessibility palettes

■■ The Font and Paragraph palettes
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Adobe Acrobat

In addition to previewing your Designer forms, you’ll need Acrobat for some of 
the exercises in Part 2, “PDF Forms.” If you don’t have Acrobat, you can either 
buy it or download a free trial version from www.adobe.com.

The Companion Site
Throughout the book, you’ll see this globe icon next to a topic with more infor-
mation on the book’s companion site: www.smartdoctech.com/support.

You’ll find support materials on this site, including the following:

■■ Additional bonus articles and exercises for LiveCycle Designer.

■■ Links to important information in the Adobe Help System, Knowledge 
Base, and Developer Connection.

■■ FAQ (Frequently Asked Questions) about the book.

■■ Errata: The exercises in this book have been reviewed many times by sev-
eral technical editors. However, as with all human endeavors, it’s possible 
that something is incorrect. If you find an incompatibility with one of the 
sample files, please report it to support@smartdoctech.com.

The Sample Files
You can also download the sample files from the book’s companion site. You 
need these files to work through the hands-on exercises in this book.

Moving On
Now that you know what to expect, let’s get started by learning the features 
and functions of Adobe LiveCycle Designer.

http://www.adobe.com
http://www.smartdoctech.com/support
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PDF and Acrobat

There is no such thing as fun for the whole family.

— Jerry Seinfeld

Portable Document Format (PDF) is actually a family of file formats, and this 
chapter focuses on the ones that are relevant to LiveCycle Designer. You’ll learn 
how to create these various types of PDFs and understand how and why to use 
each one. All these types work best in the premier client tool for viewing and 
working with PDFs—Adobe Acrobat.

Like PDF, Adobe Acrobat is a family with many members. It’s important to 
understand the features of the various Acrobat programs because their features 
affect how your PDF forms function. Acrobat has the agility to run as a stand-
alone application or as a plug-in to your web browser, and it gracefully balances 
these two modes. It can also handle the requirements of different types of users 
working with different types of PDFs. And it works on virtually every computer 
system and renders PDF files faithfully and efficiently regardless of the system’s 
fonts and software.

Although Acrobat is the ideal tool, there are also many non-Adobe PDF viewers 
on the market. If you’re deploying PDFs to a heterogeneous user base, you need 
to know how your PDFs will perform in these third-party tools.
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The PDF Family
The term PDF refers to a family of file formats and an evolving set of techni-
cal specifications. Many of these formats and specifications are International 
Organization for Standardization (ISO) standards, and some are specific intel-
lectual property owned by Adobe.

XFA PDF (PDF Form)
Adobe uses the term PDF form to refer to the interactive and dynamic forms 
you create with Designer. It’s important to note that there’s another type of 
PDF form, called an Acroform, that’s different from the PDF forms you create 
in Designer. The forms and files you create with Designer are based on Adobe’s 
XML Forms Architecture (XFA). In many ways, the XFA PDF file format is 
closer to an HTML file than it is to a traditional PDF file. For instance, the fol-
lowing code shows you what a simple text object looks like in an XFA PDF file:

<draw name="StaticText1" y="15.875mm" x="28.575mm" w="29.2864mm"  
➥ h="5.2331mm">

 <ui>

  <textEdit/>

 </ui>

 <value>

  <text>Text</text>

 </value>

 <font typeface="Myriad Pro"/>

 <margin topInset="0.5mm" bottomInset="0.5mm" leftInset="0.5mm"  
 ➥ rightInset="0.5mm"/>

</draw>

As you can see, XFA forms are XML based. This well-structured and flexible 
format enables a LiveCycle Server to transform your Designer files into many 
different formats, including traditional PDF and HTML. You can see the com-
plete XML structure of your forms in Designer by selecting the XML Source 
tab of the Layout Editor. As you learned in Part 1, “The Designer Tool,” all the 
objects and events in these XFA PDFs are scriptable at runtime, so this PDF 
type offers you a great deal of flexibility and power. You can create both static 
and dynamic XFA forms in Designer. 
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NOTE: The step-by-step instructions in this chapter were created with Acrobat Professional 11 

for Windows. If you have a different version, the exact steps and screenshots may differ.

Static forms

Static XFA PDF forms won’t change their layout at runtime, but they can be inter-
active for the user. The following are a few advantages of static XFA PDF forms:

■n Static forms support Acrobat’s Comment and Markup tools.

■n Static forms enable you to import and export Acrobat comments.

■n Static forms support font subsetting, which you will learn about in the 
next chapter.

■n Static forms work in early versions of Acrobat like 6 and 7, but dynamic 
forms are recommended only for version 8.1 and above.

You can create a static XFA PDF in Designer with the SmartDoc Expense 
Report form that you developed in Chapter 3, “Creating the SmartDoc 
Expense Report.” Follow these steps to create and view a static PDF form:

1. Launch your Designer program, and open the expenseReportCompleted.
xdp file from the Samples folder.

2. Select File > Save As to open the Save As dialog box.

3. Enter expenseReportStatic.pdf as your filename, select Adobe Static PDF 
Form (*.pdf) as your file type, and click Save.

4. Launch Adobe Acrobat from the Windows Start menu. Please note that if 
you’re using the free Adobe Reader program, you won’t yet be able to use 
the commenting tools because this file has not been Reader extended. 
You’ll learn how to do this in an upcoming exercise.

5. Select File > Open and browse to the static PDF you just created.

6. Click the Add Expense button on the form. Notice that a new row is not 
created because this isn’t a dynamic PDF.

7. Open your Comment tools and notice that you can add comments to this 
type of PDF because it’s a static form.
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Dynamic forms

Dynamic XFA PDFs can change their layout at runtime, so the commenting 
and markup features aren’t supported. However, dynamic XFA PDFs do offer 
the following advantages:

■n Dynamic forms support client-side scripts that change the layout and 
pagination of the form. For instance, your SmartDoc Expense Report will 
expand and paginate to accommodate an endless amount of data if you 
save it as a dynamic form.

■n Dynamic forms support all the properties of your form at runtime, 
whereas static forms support only a subset (Figure 4.1).

Static

Dynamic

Figure 4.1 In static forms (top),  
you can change only the background  
fill of your text field at runtime. 
Dynamic forms (bottom) enable you 
to change almost any property of your 
form at runtime.

Follow these steps to create and view a dynamic PDF form:

8. Go back to your expenseReportCompleted.xdp file in Designer.

9. Select File > Save As to open the Save As dialog box.

10. Enter expenseReportDynamic.pdf as your filename, select Adobe Dynamic 
XML Form (*.pdf) as your file type, and click Save.

11. Launch your Adobe Acrobat or Adobe Reader program from the Windows 
Start menu.

12. Select File > Open and browse to the dynamic PDF you just created.

13. Click the Add Expense button on the form. Notice that a new row is added 
because this is a dynamic PDF.
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14. Open your Comment tools and try to add a comment. Notice that you can’t 
add comments to this type of PDF form (Figure 4.2).

Figure 4.2 Acrobat’s commenting 
features don’t work on dynamic 
PDF forms.

If your Designer form works equally well as either a static or dynamic XFA PDF 
form, Adobe recommends creating dynamic XFA PDFs for performance benefits.

NOTE: Dynamic PDF forms support all the XFA script constructs. However, HTML forms 

currently don’t support all the XFA scripting constructs. You’ll learn more about this in  

Part 3, “HTML Forms.”

PDF File (Traditional PDF)
The most popular and pervasive PDF format is the traditional PDF file. There 
are many ways of creating a traditional PDF file, including using Acrobat 
and many third-party tools. Acrobat provides all the following ways to create 
traditional PDF files. If you don’t have Acrobat installed, you may not see these 
options on your computer.

■n By capturing the print stream of a desktop application: Choose the Print 
command of an authoring application and select the Adobe PDF printer 
icon. Instead of a printed copy of your document, you’ll have created a PDF 
file of your document.

■n By using the Acrobat PDFMaker plug-in with Microsoft Office applications: 
When you install Acrobat, it adds an Adobe PDF menu to Microsoft Office 
applications and an icon to the Office ribbon. You can use these added 
features to create PDF files directly in Microsoft Office.

■n By using Acrobat Distiller to convert PostScript and Encapsulated PostScript 
(EPS) files into PDFs: Distiller is typically used in print publishing and 
other workflows that require a conversion from the PostScript format to 
the PDF format.
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Static documents

Under the hood, a traditional PDF is very different than an XFA PDF. It doesn’t 
have the same XML structure, and since it’s created by capturing the print 
stream of a file, a traditional PDF is a static and read-only file. You can create a 
traditional PDF file from a dynamic Designer file by following these steps:

1. Launch your Designer program, and open the dunningNotice.xdp file from 
the Samples folder.

2. Select File > Form Properties > Preview.

3. Select Print Form (One-sided) as your preview type.

4. Locate a data file by clicking the Browse button to the right of the Data 
Field entry field.

5. Select dunningNoticeData.xml from the Samples folder and click Open.

6. Select Dynamic XML Form as your preview type.

7. Click OK to save these preview settings.

8. Select Preview PDF to see your dynamic form merged with your data file. 
At this stage, your PDF is still an XFA PDF.

9. Press F8 on your keyboard to display the Acrobat toolbar (Figure 4.3).

Dunning Notice

SUBJECT: Status of Account

Monday, January 16, 2014

Bill To Customer Name 
Any Street 
Any City, Any State, Any ZIP

GLOBAL
company

Save A Copy

Print File

Figure 4.3 The Acrobat toolbar in Designer’s Preview PDF tab. If you click Save A Copy, 
you’ll create an XFA PDF. If you click Print File, you’ll create a traditional PDF.
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10. Click the Print File button. Select Adobe PDF as your printer, and click the 
Print button on the bottom right.

11. Enter dunningNoticeTraditional.pdf as your filename, and click Save. You 
have now created a traditional PDF file by capturing the print stream of 
your XFA PDF file. This new PDF file is static and read-only.

Dynamic documents

Since the source file for the Dunning Notice is a dynamic Designer file, the 
rendered files will grow or shrink based on the length of your data (Figure 4.4). 
There are additional data files in the Samples folder, and each has a differ-
ent amount of data. You can repeat the steps in this exercise with these data 
files to see how different PDFs will be created each time. This is an example of 
dynamic document generation. 

1 page’s worth of data 2 pages’ worth of data

Figure 4.4 The Dunning Notice is a dynamic Designer file that will grow or shrink to accommodate 
the data that’s merged with it.

PDF Is an ISO Standard

In 2008, PDF became an official ISO standard document format. ISO is a world-

wide federation of national standards organizations, and its goal is to work with 

member countries to develop and promote international standards. The American 

National Standards Institute (ANSI) represents the United States of America in 

ISO. There are approximately 100 other countries represented in ISO.
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Acroforms
Acroforms are Adobe’s older interactive form technology; they date back to 
Acrobat version 3. Adobe provides the Acrobat Forms API Reference, dated 
May 2003, to provide the technical details for this technology. You can find a 
link to this on the book’s companion site. Acroforms are a combination of the 
following items:

■n A traditional PDF that defines the static layout and graphics of the form.

■n Interactive form fields that are bolted on top with the form tools of the 
Adobe Acrobat program. Please note that these form tools are a small sub-
set of what’s available in Designer.

Acroforms can be enhanced and expanded with Designer. However, even 
when you enhance an Acroform in Designer, it’s still a traditional PDF under 
the hood, and there are limits to how interactive and dynamic you can make 
these forms. For instance, only some of the form fields in Designer’s Object 
Library are supported in Acroforms, and even the ones that work are only 
partially supported.

To move beyond the limits of Acroform technology, Adobe has invested in 
XFA to provide an XML form structure that’s both interactive and dynamic. 
If you’re moving from Acroforms to XFA PDFs, you need to know a couple of 
important facts about these two technologies:

■n Designer can edit a PDF form created in Acrobat, but Acrobat cannot edit a 
PDF form created in Designer.

■n JavaScript works differently in these two technologies. Some of the JavaScript 
routines that work in Acroforms won’t work in XFA forms. Adobe has 
documented these differences in a 43-page online PDF called “Converting 
Acrobat JavaScript for Use in LiveCycle Designer Forms.” You can find a link 
to this on the book’s companion site. As mentioned previously, Designer is 
a much more robust tool for using JavaScript in your forms, so I recommend 
that you learn how to script in Designer with the XFA object model.
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PDF/A
PDF/A (PDF for Archives) builds on the document storage benefits of tradi-
tional PDFs with many specific details that enhance long-term archiving. The 
traditional PDF file format offers many benefits for long-term document stor-
age. The compact nature of PDF facilitates easy transfer and conserves space, 
and its well-structured nature enables powerful indexing and search capabili-
ties. Traditional PDF has extensive support for metadata, and PDF has a long 
history of supporting many different computer environments.

Like PDF, PDF/A is an ISO standard specification. It was developed by a task 
force that included AIIM (Association for Information and Image Manage-
ment), NPES (National Printing Equipment Association), and the Administra-
tive Office of the U.S. Courts. Since the goal of the PDF/A specification is to 
provide a long-term archive format, many PDF features are omitted so the files 
can be self-contained. The following are some key points about the specifica-
tion that enhance the long-term reproducibility of the PDF/A file:

■n All content must be contained in the file, and there can be no dependen-
cies on external sources like hyperlinks, fonts, or software programs.

■n All fonts must be embedded, and they need to be fonts that have an 
unlimited-use license for electronic documents.

■n JavaScript isn’t allowed.

■n Transparency isn’t allowed.

■n Encryption isn’t allowed.

■n Audio and video content aren’t allowed.

■n Color spaces must be defined in a device-independent way.

■n All metadata must follow certain standards.

Different PDF/A versions

Although the original standard was based on Adobe’s PDF Reference Version 
1.4, the ISO technical committee maintains the specification and has created 
the following versions:

■n PDF/A—1b: This level is based on PDF version 1.4, and it ensures that the file 
can be accurately reproduced visually on a computer system in the future.
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■n PDF/A—1a: This level is also based on PDF version 1.4, and it includes all 
the requirements of 1b plus some additional requirements to ensure the 
long-term reproducibility of the document’s text stream in other devices 
besides a traditional computer.

■n PDF/A—2: This is a newer specification (released 2011), and it addresses 
some of the new features in PDF versions 1.5, 1.6, and 1.7.

■n PDF/A—3: This is the newest specification (released 2012), and it allows 
embedding of compliant archived objects, including XML, word process-
ing, and spreadsheet documents.

Viewing a PDF/A file

Two files in the Samples folder were created from the same Microsoft Word 
file. One was created as a traditional PDF and the other as a PDF/A file. Open 
these two files in Acrobat Professional:

■n simpleWordFile.pdf

■n simpleWordFilePDFA.pdf

Although the documents look the same, the PDF/A file opens with a blue bar 
across the top, indicating that you’re viewing this document in PDF/A mode. 
This blue bar is Acrobat’s document message bar (Figure 4.5), which you’ll see 
when you open certain types of PDF files.

This file claims compliance with the PDF/A standard and has
been opened read-only to prevent modification.

Figure 4.5 Acrobat’s document message bar highlighted in blue.

The document message bar includes instructions, and possibly buttons, to 
help you complete a task. It’s color coded, and you’ll see the blue color when 
you open special types of PDFs (like this PDF/A file) as well as certified and 
digitally signed PDFs. The bar changes to purple for PDF forms and to yellow 
when you’re participating in a PDF review.

NOTE: It’s possible that your document message bar is hidden. You can change this Acrobat 

setting by going to Edit > Preferences > Forms > and deselecting Always Hide Forms Document 

Message Bar.
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This message bar indicates that your file conforms to the PDF/A specification. 
Another compliance indicator is found in the Results pane of Acrobat Profes-
sional’s Preflight tool. Follow these steps to see how it works:

1. Open the simpleWordFilePDFA.pdf file in Acrobat Professional if it isn’t 
already open.

2. Choose Tools > Print Production > Preflight to open the Preflight dialog 
box (Figure 4.6). If you don’t see this option, select the Show Or Hide Panels 
option in the Tools drop-down in the upper-right corner of the Tools panel.

3. Scroll down to the PDF/A compliance section and select Verify Compli-
ance With PDF/A-1b.

4. Click the Analyze button at the bottom of the dialog box. Acrobat will com-
pare your file to the PDF/A-1b profile and issue a report (Figure 4.7).

Figure 4.6 The Acrobat Preflight tool shows 
you various PDF/A profiles that you can test 
your file against.

Figure 4.7 The Acrobat Preflight tool 
shows you the results of the analysis. 

If you go back to the Profiles tab and compare your file against other PDF/A 
profiles, you’ll find that it doesn’t meet all requirements. You can also open 
simpleWordFile.pdf and see the issues that this file has. Experiment with the 
features of this tool. In many cases, you can use the Convert To PDF/A options 
to make your PDFs compliant with the various specifications. In some cases, 
you’ll need to go back to the source files of your PDFs and make changes in 
order to reach compliance. LiveCycle Server can automatically convert your 
Designer files into PDF/A documents.
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The Acrobat Family
Now that we’ve reviewed the PDF family of file formats, let’s take a look at the 
Acrobat family of software tools. The Acrobat family includes various com-
mercial versions of the software used to create and view PDFs, and the free 
Adobe Reader program used to view PDFs. You can launch Acrobat/Reader as 
a standalone application and work with it in the same way that you use tradi-
tional desktop software. Acrobat/Reader is also launched automatically when 
you navigate to a PDF file with your web browser if your web browser’s default 
PDF Viewer is set to Acrobat/Reader (Figure 4.8).

Expense Report
Date Requested:   10/30/2009 

Employee

First Name

James

Last Name

Terry

Client Name

Other

Other Client Name

Fidelity

Notes

This was a one day trip to meet with the Fidelity e-Business team and National Financial on Summer Street

Microsoft Internet Explorer

Figure 4.8 When you view a PDF on the web, Acrobat/Reader will launch 
as a browser plug-in.

All versions of Acrobat and Reader work in this dual way, and all can be used 
to view PDF forms and files. However, because each is unique, you should be 
aware of your users’ versions so you know their capabilities.

Adobe Reader
You can download the free Reader program for various languages and operat-
ing systems, including Windows, Macintosh, and Linux. It’s the only free PDF 
file viewer that works with the entire PDF family of file types. Adobe updates 
Reader when it updates the commercial versions of Acrobat, so the XFA sup-
port is synchronized between the two products. Reader has the same look and 
feel as the rest of the family but only a subset of the functionality.
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As its name implies, Reader is primarily used to read or view PDF files. How-
ever, the functionality of Reader can be extended through Reader Extensions. 
You apply Reader Extensions at the file level. When these extensions have been 
applied to a file, a user’s Reader application automatically unlocks the Acro-
bat features that have been lying dormant in the program. There are multiple 
ways and reasons to apply Reader Extensions. For instance, if your user base 
only has Reader but you need your users to participate in a document review 
process, you can Reader extend the file. Once the file is extended, your Reader 
users can access the Acrobat commenting tools, including sticky notes, high-
lighting, and stamps. Another valuable use of Reader Extensions is to give 
Reader users the ability to save their data with their form.

Acrobat Standard
Acrobat Standard is available for the Windows platform. This version contains 
most of the Acrobat features and includes the ability to do the following:

■n Reader extend a file so users of Reader 8 or later can save form data

■n Create a PDF document from any application that can print a file

■n Scan paper documents and convert the text to digital text with Acrobat’s 
OCR (optical character recognition) functionality

■n Apply restrictions on copying, printing, and changing PDF files

■n Encrypt and digitally sign PDFs

■n Save PDFs in the PDF/A (PDF for Archives) format

Acrobat Professional
Acrobat Professional is available for the Windows and Macintosh platforms. 
Acrobat Professional includes the following tools in addition to those found in 
Acrobat Standard:

■n Redaction tools, used to permanently delete specific text and illustrations 
(Redaction tools are used by legal professionals to completely remove sec-
tions of a document.)

■n High-end print production and digital publishing tools, used to preflight 
and correct PDF files

■n Optimization tools, used to enhance PDF reading experiences for 
mobile users
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Acrobat Professional also enables you to

■n Validate PDF documents against ISO standards, including PDF/A,  
PDF/X (high-end graphics), PDF/E (engineering), and PDF/VT  
(variable-data printing)

■n Combine a wide range of file types into a PDF Portfolio with custom 
layouts, themes, and colors

■n Compare two different PDFs and highlight the differences between them

■n Create and validate accessible PDF files to meet WCAG (Web Content Acces-
sibility Guidelines) 2.0 and PDF/UA (Universal Accessibility) standards

■n Insert Flash video (FLV format) and H.264 video into PDF files

■n Automate PDF creation tasks

Understanding Reader Extensions
As mentioned, some of the interactive and dynamic features in your forms 
won’t work in Reader until the form has been Reader extended. In this sec-
tion, you’ll learn about the limitations of Reader and how to transcend these 
confines with Reader Extensions.

Understanding Adobe Reader Limitations
Although Reader is primarily used to read or view PDF files, you’ll often need 
your Reader users to do more to effectively participate in your smart form 
workflow. Fortunately, you can extend the features of Reader by applying 
Reader Extensions to your PDF forms. In this section, you’ll explore the follow-
ing two files to understand and transcend Reader’s limitations.

■n notReaderExtended.pdf: This file was created in Designer and saved as a 
dynamic XFA PDF.

■n readerExtended.pdf: This is the same file created in Designer, but it was also 
Reader extended with LiveCycle Reader Extensions.
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Saving data with the form

Believe it or not, Reader users won’t be able to save a copy of your PDF form 
with their data until the form has been extended. When a nonextended PDF 
is opened, Reader displays a message in the document message bar. If you 
open the notReaderExtended.pdf file in Reader 9 or above, you’ll see a purple 
document message bar with the following message: Please fill out the follow-
ing form. You cannot save data typed into this form. Please print your completed 
form if you would like a copy for your records.

Although it’s helpful to know this before filling in a complex form, it’s hardly 
in keeping with a smart form workflow to print out the form to retain the 
data. It’s usually best to store the information digitally; your Reader users will 
be able to do this after the form is extended. Look at the readerExtended.pdf 
file, and you’ll see a purple document message bar with the following mes-
sage: Please fill out the following form. You can save data typed into this form. 
You’ll also need to Reader extend a form if you want to use Reader to import or 
export XML data into PDF forms at runtime.

Using digital signatures

Digital signatures play an important role in secure smart form workflows. Just 
think about the many times you have had to sign paper documents. Digital 
signatures will replace the tasks in your workflow that previously required a 
handwritten signature on paper. In many ways, digital signatures are more 
trustworthy than traditional signatures, and there are various ways that you 
can use them in your Designer forms.

When you open the notReaderExtended.pdf file in Reader 9 or later, the digital 
signature field is unresponsive. However, when you open the readerExtended.
pdf file, you’re able to sign the document by clicking the digital signature field.

Connecting to data in real time

The two sample files you’ve been working with also contain a connection to 
a web service. However, you’ll notice that this web service call works only in 
the Reader extended file. Follow these steps to call a web service from that 
sample file:

1. Open the readerExtended.pdf sample file in Adobe Reader 9 or later.

2. Enter 1001 in the Enter ID field.
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3. Click the Call Web Service button. This will call a web service at the 
SmartDoc data center to retrieve a record from a Microsoft SQL Server 
database. Depending on your security settings, you may see Acrobat 
Security Warning messages like the one in Figure 4.9. You’ll need to trust 
this document as explained in step 5 to bypass these messages.

Figure 4.9 The Acrobat Security 
Warning message.

4. Deselect the “Remember this action for this site for all PDF documents” 
option, and click Allow.

5. Click the Options drop-down list in the Acrobat document message bar, 
and select “Trust this document one time only.”

6. Click No if you’re prompted to save changes.

7. Now that the security questions are answered, you can enter 1001 in the 
Enter ID field, and click the Call Web Service button.

The data will automatically flow into the form fields of the PDF. This hap-
pens because the form has been Reader extended and the fields are bound 
to the data connection.

If you try to repeat the preceding steps in Adobe Reader with the notReaderEx-
tended.pdf file, nothing will happen when you click the Call Web Service button.

NOTE: Acrobat has sophisticated security features, and Adobe provides features and tech-

niques for tuning your PDF applications to meet both your security and functionality require-

ments. For instance, you can create trusted JavaScript functions that will be handled differently 

by Acrobat than your standard JavaScript functions.

Submitting electronic forms

Some types of electronic form submission won’t work in Reader until the file has 
been extended. Reader enables you to submit XML data from a nonextended 
form, but if you want to submit the form and the data, the form must be Reader 
extended. Follow these steps with your sample files to see how this works:

8. Open the readerExtended.pdf sample file in Adobe Reader 9 or later.
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9. Click the Submit Form button. The Send Email dialog box appears 
(Figure 4.10).

10. If you have Microsoft Outlook, select Default Email Application, and click 
Continue. Acrobat passes this form to your Outlook program. Note that 
this functionality doesn’t work with all email programs.

The Outlook screen shows your email message with your attached PDF form 
(Figure 4.11).

Figure 4.10 The Send Email dialog box. Figure 4.11 An Outlook email message with an attached 
PDF form.

If you’re using Reader and you try to click Submit Form in the notReader 
Extended.pdf file, nothing will happen. Form submission isn’t supported in 
Reader until the form has been Reader extended. However, you can submit 
the XML data. Click the Submit Data button and you’ll be able to complete 
the process.

The Submit Data button will work with both files. This button will submit your 
form data as an XML email attachment. Reader supports XML data submis-
sion for both extended and nonextended forms.

Using barcodes

You may sometimes need to integrate paper-based tasks in a digital workflow. 
Barcodes can help you do this. For instance, if you send an interactive PDF 
form to users and they fill it out with Reader, they may not necessarily submit 
the form to you electronically. For various reasons, your users may decide to 
print out the form and submit it via fax or traditional mail.

In these cases, barcodes can encode the users’ form data as they enter it into 
Reader. You saw an example of this at the end of Chapter 2, “Scripting and 
Advanced Techniques.” These barcodes on the paper forms can be scanned, 
and the data they contain will be automatically read into your back-end 
system. If you open the readerExtended.pdf file in Reader 9 or later, you’ll see 
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the barcode in action. The code is wired to encode the data only in the Name 
field. As you make changes to this data, the visual appearance of the barcode 
changes. This barcode is an instance of Adobe’s Paper Forms barcode, which 
you can add to your forms with Designer. This two-dimensional barcode is 
read by a barcode scanner, which retrieves the data you entered in the Name 
field. You can encode most types of form data into a barcode.

Attaching files

Acrobat enables users to attach other files to a PDF. This capability is useful in 
cases when a user wants to include supporting documents with a form. These 
files appear in the Attachments panel, which is always available in Acrobat 
and active in Reader when a PDF has been extended. Follow these steps to see 
how to add attachments to PDF forms and files:

11. To open the Attachments panel in Acrobat, select View > Show/Hide > 
Navigation Panes > Attachments. Alternatively, you can click the paperclip 
icon in the Navigation pane on the left of the main window.

12. Click the drop-down list and select Add Attachment (Figure 4.12, left). 
The Add Files dialog box will open.

13. Select the file you need to attach to your PDF form and click Open. Your 
attached file now displays in the Attachments panel.

You won’t see this option in Reader when you open the notReaderExtended.
pdf file. However, when you open the readerExtended.pdf file, this feature is 
enabled. You can also open the Attachments panel in Reader by clicking the 
icon in the Extended Features panel that displays in Reader when a Reader 
Extended file is active (Figure 4.12, right).

Figure 4.12 The Attachments 
panel (left) and the Extended 
Features panel in Reader (right).
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Using the Comment and Markup tools

The Acrobat Comment and Markup tools aren’t normally a feature of Adobe 
Reader. However, these tools lie dormant in the program and can be activated 
when a Reader extended PDF form is opened. Remember, it must be a static 
XFA PDF in order for you to use these tools. You’ll Reader extend a static form 
in the next exercise.

Extending a PDF Form with Acrobat
Now that you’ve learned the benefits of Reader extending your form, it’s time 
to learn how to do so with a hands-on exercise. There are two tools you can 
use to extend a form: 

■n Adobe Acrobat will do a partial Reader extension of your PDF form.

■n LiveCycle Reader Extensions will do a complete extension of your XFA PDF. 
LiveCycle Reader Extensions is a LiveCycle Server module that needs to be 
licensed from Adobe separately from Acrobat.

Partial Reader extension with Acrobat Professional

These steps allow you to Reader extend a form using Acrobat Professional:

1. Open the changeOfBeneficiaryStatic.pdf form in Adobe Reader. Notice 
that the commenting tools in the upper right are grayed-out and inactive.

2. Close the changeOfBeneficiaryStatic.pdf form in Adobe Reader.

3. Open the changeOfBeneficiaryStatic.pdf form in Acrobat Professional.

4. Select File > Save As Other > Reader Extended PDF > Enable More Tools 
(includes form fill-in and save).

Acrobat displays a message box describing the features that will be avail-
able for this file when it’s opened in Reader (Figure 4.13).

Figure 4.13 Enabling Adobe Reader 
usage rights.
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5. Click Save Now to open the Save As dialog box.

6. Change the filename to changeOfBeneficiaryStatic_RE.pdf and click Save. 

Your file is now Reader extended, and it supports the following features:

■n Saving data with the form

■n Using the Comment and Markup tools

■n Submitting electronic forms

■n Using digital signatures

7. Open your new changeOfBeneficiaryStatic_RE.pdf in Adobe Reader. 
Notice that the commenting tools in the upper right are now active.

NOTE: The Adobe Acrobat EULA (End User License Agreement) includes a limit of 500 unique 

data responses for a Reader extended document. If you work for a government agency or a corpo-

ration with needs that extend beyond this limit, you must buy LiveCycle Reader Extensions. You 

can read the complete Adobe Acrobat EULA at www.adobe.com/products/eulas.

Although Reader extending with Acrobat Professional is good for many cases, 
you’ll have to extend your forms with LiveCycle Reader Extensions if you need 
Reader users to access any of the following functionality in your XFA PDFs:

■n Connecting to data in real time

■n Using barcodes

■n Attaching files

Complete Reader extension with LiveCycle Reader Extensions

To completely Reader extend your PDF forms, you need to use LiveCycle 
Reader Extensions. Unlike the previous Acrobat method, Reader Extensions 
can extend files at design time and at runtime. If you have a license for this 
LiveCycle Server module, you can extend a file at design time by launching 
your browser and navigating to the Reader Extensions URL of your LiveCycle 
Server. The path will follow this format.

http://[Server Address]:[Port Number]/ReaderExtensions

After you log in with your username and password, the main screen appears 
(Figure 4.14). You can select your PDF file and your usage rights on this screen. 
After making your choices, click Apply to Reader extend your file.

http://www.adobe.com/products/eulas
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Figure 4.14 The web interface for LiveCycle Reader Extensions. You need this software to enable 
Reader users to work with barcodes and embed file attachments.

Since this module runs as a LiveCycle service, you can call it at runtime from 
your LiveCycle, Java, or .NET programs. This is an ideal module to use at 
runtime to make sure all users of your form will realize its full functionality 
regardless of whether they are using Acrobat or the free Reader program. As 
you can see in Figure 4.14, you can even add a custom message that users will 
see when they open your Reader extended files.

NOTE: Adobe LiveCycle Reader Extensions is one of Adobe’s LiveCycle Server modules for 

automating enterprise forms and documents. Other important modules include Forms Standard 

and Pro, Forms Portal, Output, PDF Generator, Rights Management, Digital Signatures, Process 

Management, and Correspondence Management.
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Third-Party Viewers
There are over 20 commercially available PDF viewing/reading applica-
tions for Windows and many others available for tablet devices. Bear in mind 
that these programs were designed to open, view, and sometimes annotate 
traditional PDF files. They weren’t designed to work with your interactive and 
dynamic XFA PDF forms.

Because they were designed to read traditional PDF files, these third-party 
PDF viewers are typically lightweight applications that don’t include a 
JavaScript engine or support for Adobe’s XFA object model. If your user base 
includes third-party PDF readers and you’re using XFA PDF forms, it’s best to 
advise your end users to open your forms with the free Adobe Reader. This will 
enable them to realize all the features and functionality in your forms.

Viewing PDFs on Tablet Devices
Your XFA PDFs also won’t work in the third-party PDF viewers that are avail-
able for the Apple iPad and Android tablets. Even Adobe’s own Reader appli-
cation for tablet devices doesn’t support XFA PDFs. If you’re targeting mobile 
devices with your Designer forms, you should render them as HTML mobile 
forms; you’ll see how to do this in Part 3, “HTML Forms.”

Web Browsers with Default Viewers
But perhaps the biggest challenge with non-Adobe PDF readers is the new web 
browsers that include their own default PDF viewers. The following is a short 
list of web browsers that have a non-Adobe PDF viewer as their default helper 
application for PDF files:

■n Apple Safari defaults to Apple’s own Preview application.

■n Google Chrome includes a default viewer that opens PDFs directly in the 
browser window.

■n Mozilla Firefox has its own default PDF viewer.

Changing the default for Google Chrome

Fortunately, you can change your browser’s default PDF viewers. Follow these 
steps to change the default PDF helper application in the Google Chrome browser:

1. Launch your Google Chrome browser.
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2. Enter chrome://plugins in the navigation bar, and press Enter. You’ll see the 
Chrome Plug-ins panel (Figure 4.15).

3. Click Disable in the Chrome PDF Viewer section (Figure 4.15).

If you have Adobe Acrobat or Adobe Reader on this machine, you can 
enable it as your default PDF viewer for Chrome. If you don’t have it, you 
must download it first before proceeding with these next steps.

4. Scroll down in your Plug-ins panel until you see the entry for Adobe Acro-
bat or Reader. Click the Enable link. You will see the grayed-out version 
become active (Figure 4.16).

5. Press Ctrl+O on your keyboard to launch Google’s Open File dialog box.

6. Browse to the dynamic XFA PDF expenseReportDynamic.pdf, which you 
created earlier in this chapter.

7. Click Open, and you’ll see your Acrobat/Reader plug-in working inside 
the Google Chrome window. You now have the full functionality of your 
dynamic form.

Figure 4.15 The Google Chrome Plug-ins panel. Figure 4.16 Enabling Adobe Acrobat in Google Chrome.

For current information on this topic and to learn how to change the default 
PDF viewer in other browsers, please refer to the book’s companion site.

Moving On
Now that you know more about PDF file types and PDF viewers, let’s move on 
to review the best practices for creating PDFs with Adobe LiveCycle Designer.
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documenting, 48–49
overview of, 46–47
propagating, 51–52
Show Events drop-down list, 223
types of, 47, 50
updating PDF form for HTML, 205–206

Exception handling
catch block, 65
displaying data in form, 66
overview of, 63–64
try block, 64–65

Exceptions, JavaScript, 63
Expense Report. See SmartDoc Expense Report form
Explicit data binding, 19
External style sheets, 28

F
Fields

Date and Time fields, 23–24
Missing Required Fields warning, 225
validating, 21

File attachments, Reader extensions and, 125
File formats, options for saving forms, 8
File Transfer Protocol (FTP), 232
File utility, base components of LiveCycle Enterprise 

Suite, 232
Fill Color, for background subform, 212
Font mapping, 146
Font Properties dialog, 200
Font Subsetting, 147
Fonts

default, 24–25
modifying font map, 146
overview of, 145
replacing form’s font, 146–147
right-side palettes for working with, 7
updating PDF form for HTML, 199–202
updating PDF form for HTML by editing XML 

source, 202–203
web-safe, 180

Fonts, in Acrobat
embedding, 144–145
list of standard, 143
substitution feature, 144



 INDE X 261

Fonts, on the server
Font Subsetting, 147
overview of, 147
rendering PDFs, 148

Form fragments
creating, 140–141
at design time, 138
embedding, 139–140
HTML forms and, 187–189
overview of, 138
at runtime, 141–142
using, 139

Form management, LiveCycle Enterprise Suite
Forms Manager application, 243–246
modules and, 241–243

Form objects, controlling appearance at runtime, 31
Form validation, 21
Form variables, 39–40
Formats

date formats and localization, 148–149
file formats, 8
multiple format support, 3

Formatting, scripts for, 31
FormCalc

built-in functions, 34–35
Designer support for, 33–34
shortcuts for writing references, 44
shortcuts to current object, 44
statement completion feature, 35–36

Forms Manager
modules and, 241–243
overview of, 142
working with, 243–246

Forms Pro ES4. See LiveCycle Forms Pro ES4
Foundation, LiveCycle Enterprise Suite, 231–233
Fragment Library

adding form fragments to, 138
right-side palettes for creating/editing form 

objects, 7
using form fragments from, 139

Fragments. See Form fragments
FTP (File Transfer Protocol), 232
Fully qualified references, referencing objects in 

scripts, 42
Functions

adding to script objects, 53–58
calling, 58–60
referencing, 104, 223–225

G
Global data binding, 18
Google

Android Development Toolkit (ADT), 253
Android devices, 176
Android mobile apps, 253
Google Chrome, 129

Graphics
comparing HTML and XFA forms, 180–181
for HTML forms, 187
optimizing form performance, 153–154

H
Hard disk, caching files in, 164
Hearing disability, accessibility and, 150
Help system, 48–49
Hidden subforms, 14–15
Hierarchy palette

Border palette option, 212, 226
duplicating subforms, 215
Insert Script Object option, 222
Insert Subform option, 212–213
left-side palettes for organizing forms, 5–6
selecting subform from, 94
validation script object, 223

Host
adding host detection script, 205–206, 209
comparing HTML and XFA forms, 178–179

HTML forms
Address Change Form example. See Address 

Change Form
browser support, 176
built-in patterns, 19
Date field display patterns, 182, 203–204
dynamic flow and pagination, 179–180
host for, 178–179
JavaScript support, 36
layout and graphics, 180–181
number field display patterns, 182
overview of, 168–169
pagination and subform flow in, 12
patterns, 181–182
previewing with Designer, 169–171
previewing with Mobile Forms IVS, 171–174
scripting and events, 183
similarities and differences with XFA forms, 177
XFA to HTML transformation, 174–176

HTML forms, best practices
custom profiles, 190–193
custom widgets, 193–194
data submission, 194–197
development strategies, 185–187
form fragments, 187–189
graphics, 187
overview of, 184
signatures, 190
tables, 189
target versioning, 185
testing with different browsers, 185

HTML version, of LiveCycle Workspace, 249
HTML5, 169
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I
Images

comparing XFA and HTML forms, 181
managing multiple instances of, 165
optimizing caching of resource files, 162

Implicit data binding, 18
Insert Script Object option, Hierarchy palette, 222
Insert Subform option, Hierarchy palette, 212
Insert Table dialog, table menu, 16
Installation Verification Sample (IVS). See Mobile 

Forms IVS (Installation Verification Sample)
Interactive events

example of, 51
JavaScript Date class and, 66
list of, 50

Interface, workspace, 4
Internal style sheets, 26–27
International Organization for Standardization (ISO)

PDF family, 109
PDF/A format, 116

Invisible subforms, 14–15
iOS

browser support, 176
mobile apps, 252–253

iPad, 250–252
ISO (International Organization for Standardization)

PDF family, 109
PDF/A format, 116

IVS (Installation Verification Sample). See Mobile 
Forms IVS (Installation Verification Sample)

J
J2EE, LiveCycle Enterprise Suite based on, 231
Java Database Connectivity (JDBC), 232
JavaScript

Action Builder, 67
adding functions to script objects, 223
advantages of, 36
arrays, 61–62
comparing Designer scripting to HTML 

scripting, 30
Date class, 66–67
Designer support, 33–34
exception handling, 63
functions, 54
JavaScript Debugger, 73–74
mobile forms support, 169
scripting code rationalization, 52–53
shortcuts to current object, 44

JDBC (Java Database Connectivity), 232

K
Kerning, 180
Key performance indicators (KPIs), in LiveCycle 

Process Management module, 248
KPIs (key performance indicators), in LiveCycle 

Process Management module, 248

L
Layout

comparing HTML and XFA forms, 180–181
right-side palettes for creating/editing form 

objects, 7
updating PDF form for HTML, 208–209

Layout, of Address Change form
approval subform, 216–217
background subform, 211–212
business and family subforms, 215–216
individual subform, 212–214

Layout Editor
changing fonts by editing XML source, 202–203
creating body page and subforms, 89–91
overview of, 4–5
Preview HTML and, 203

Layout palette, creating subforms, 211–217
LDAP (Lightweight Directory Access Protocol), 232
Legacy version, of LiveCycle Workspace, 249
Library palette, 77
Lightweight Directory Access Protocol (LDAP), 232
LiveCycle Designer, introduction

binding blank form to XML schema, 21–23
body pages, 11
creating new forms, 3
customizing workspace, 24
data binding, 18–19
data formatting, 19–20
data validation, 20–21
Date and Time fields, 23–24
default fonts, 24–25
dynamic tables, 17–18
hidden and invisible subforms, 14–15
how subforms work, 12–13
Layout Editor, 4–5
left-side palettes for organizing forms, 5–6
master pages, 9–11
overview of, 2–3
right-side palettes for creating/editing form 

objects, 7
saving forms, 8
Script Editor, 5
style sheets, 26–29
subform structure, 11–12
Table Assistant and Table menu, 16
Table objects, 15
workspace interface, 4

LiveCycle ECM Connectors ES4, 241
LiveCycle Enterprise Suite (ES)

development tools, 235–236
document generation, 237–241
endpoints for LiveCycle services, 236–237
form management, 241–243
Forms Manager application, 243–246
foundation of, 231–233
overview of, 230–231
solution components, 233–235
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LiveCycle Forms Pro ES4
business benefits of using, 188–189
CSS and SVG support, 177
HTML forms support, 169
table features, 189

LiveCycle Process Management module
LiveCycle Workspace program, 249–250
Mobile Workspace app, 250–252
overview of, 248

Localization, 148–150
Log messages, in optimizing performance, 158
Log tab, Report palette

overview of, 70–71
sending performance messages, 158

M
Mac OSs

Acrobat support, 120
browser support, 176

Markups, Reader extensions and, 126
Master File Strategy, for HTML form development, 

185–186
Master pages

creating, 87
Layout Editor tabs and, 5
overview of, 9–11
for SmartDoc Expense Report, 88–89

Merge Cells, table menu options, 16
Microsoft Windows OSs

Acrobat support, 120
browser support, 176

Missing Fonts dialog box, 147
Missing Required Fields warning, 225
Mobile forms

CSS and JavaScript support, 169
Mobile Forms profile, 173

Mobile Forms IVS (Installation Verification Sample)
how it works, 173–174
previewing Address Change Form, 227–228
previewing forms in different browsers, 185
previewing HTML forms, 171–172
testing tables in different browsers, 189

Mobile strategies
advantages of native apps, 254–255
Apple iOS apps, 252–253
benefits of using LiveCycle approach, 256–257
Google’s Android apps, 253
native apps, 252
overview of, 247
using native form app, 255–256

Mobile version, of LiveCycle Workspace, 249
Mobile Workspace app

creating forms online or offline, 251
customizing, 252
overview of, 250–251
Xcode IDE and, 253

Modules
Adobe solution components, 234
for enterprise form management, 241
process management, 248–252

Multiple Master File Strategy, for HTML form 
development, 186–187

N
Naming variables, 39
Native apps

advantages of, 254–255
benefits of using LiveCycle approach, 256–257
overview of, 252
using native form app, 255–256

New Data Connection wizard, 91–93, 217
New Form Assistant, 87
Number fields, comparing HTML and XFA forms, 182
Numbers, localization and, 149

O
Object Library

creating custom object library, 86
creating custom objects, 136–137
Date and Time fields, 23–24
right-side palettes for creating/editing form 

objects, 7
Standard Object Library, 210

Object palette
Binding tab, 218
Subform panel, 215–216

Objective-C language, in developing iOS apps, 252
Objects

adding SmartDoc objects to library, 86
comparing Designer scripting to HTML 

scripting, 30
creating custom, 136–137
object-orientation in JavaScript, 36
right-side palettes for creating/editing, 7

Optimizing performance
balancing performance and functionality, 159
cache optimization, 162–164
configuring form for caching, 164
data binding, 157–158
form strategies, 153–154
log messages, 158
maintaining unique UUID, 165
managing multiple instances of an image, 165
scripting, 155–157
by submitting PDF file, 161–162
by submitting XML file, 159–161

Options dialog box
setting default fonts, 24
setting default style sheets, 29
tab order options, 76–77

OSs (operating systems)
Apple. See Apple OSs
Google. See Android OS
Microsoft. See Microsoft Windows OSs
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P
Page breaks

balancing performance and functionality, 159
dynamic flow and, 179–180

Pagination
comparing HTML and XFA forms, 179–180
updating PDF form for HTML, 208–209

Palettes, on interface. See also by individual palette
for creating/editing form objects (right side), 7
for organizing forms (left side), 5–6

Paragraph options, 7
Patterns

comparing HTML and XFA forms, 181–182
updating PDF form for HTML, 206

Patterns dialog box, 182
PDF (Portable Document Format). See also Acrobat 

software
Acroforms, 115
family of file formats, 109
overview of, 108
PDF files (traditional), 112–114
PDF/A, 116–118
third-party viewers, 129–130
XFA PDF, 109–112

PDF files
converting EPS files to, 112
dynamic documents and, 114
options for saving forms, 8
overview of, 112
rendering fonts on server, 148
static documents, 113–114
use cases requiring, 161–162
viewing on tablet devices, 129
viewing with Adobe Reader, 120

PDF for Archives. See PDF/A (PDF for Archives)
PDF forms. See also XFA (XML Forms 

Architecture) PDF
comparing with HTML forms, 177
Font Subsetting for static PDF forms, 147
JavaScript support, 36
left-side palettes for organizing, 6
optimizing performance of. See Optimizing 

performance
pagination and subform flow, 12
Reader extensions and, 126–128
saving data with form, 122
updating to HTML forms. See SmartDoc Expense 

Report form, updating for HTML
PDF forms, best practices

accessibility, 150–153
balancing performance and functionality, 159
cache optimization, 162–164
custom objects, 136–137
data binding, 157–158
fonts in Acrobat, 143–145
fonts in Designer, 145–147
fonts on the server, 147–148

form fragments at design time, 138–141
form fragments at runtime, 141–142
localization, 148–150
log messages, 158
managing multiple instances of an image, 165
optimizing performance, 153
PDF files, 161–162
scripting, 155–157
strategies for form graphics, 153–154
target versioning, 132–133
templates, 134–135, 138
UUIDs (universally unique identifiers) and, 165
XML files for performance optimization, 159–161

PDF417 barcodes, 79
PDF/A (PDF for Archives)

overview of, 116
versions, 116–117
viewing, 117–118

PDFMaker plug-in, 112
PDFOutput activity, 239
Performance optimization. See Optimizing 

performance
Plain text, balancing performance and functionality, 

159
Preview HTML

Layout Editor tabs, 5, 203
viewing CSS elements on forms, 226
viewing Signature Scribble object, 210
viewing updated calculation script, 207
viewing updated layout, 208
viewing updated patterns, 206

Preview PDF
Layout Editor tabs, 5
previewing dynamic subforms, 93
previewing HTML forms, 169–171
seeing scripts in action, 51
viewing CSS elements on forms, 226
viewing Signature Scribble object, 210
viewing updated calculation script, 207
viewing updated patterns, 206

Previewing HTML forms
with Designer, 169–171
with Mobile Forms IVS, 171–174

Process events
example of, 50–51
list of, 47

Process Management module
of LiveCycle Workspace, 249–250
Mobile Workspace app and, 250–252
overview of, 248

Profiles
customizing for HTML forms, 190–193
Mobile Forms profile, 173

Progressive disclosure, in SmartDoc Expense Report, 
99–100
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R
Radio buttons

balancing performance and functionality, 159
comparing layout and graphics in XFA and HTML 

forms, 180
RAM, file caching and, 164
Reader extensions. See also Adobe Reader

Acrobat Professional for partial extension, 
126–127

LiveCycle Reader Extensions, 127–128
understanding limitations of Adobe Reader, 

121–126
Red, green, blue (RGB), in background subform, 212
Referencing objects, in scripts

abbreviated references, 43–44
fully qualified references, 42
overview of, 41–42
referencing current object, 44
referencing functions in script objects, 104
referencing multiple objects with same name, 45–46
referencing unnamed objects, 45
SmartDoc Expense Report, 102–103

Regular expressions, 60–61
Relative data binding, 157–158
Relative positioning, abbreviated references and, 43–44
Remoting endpoint, in LiveCycle services, 235
Replace dialog, 202–203
Report palette

Binding tab, 69–70
Log tab, 70–71, 158
overview of, 68
Warnings tab, 68–69, 132

REST (Representational State Transfer)
compared with web services, 194–197
document generation and, 238
endpoints for LiveCycle services, 235

RGB (red, green, blue), in background subform, 212
Rich text, balancing performance and 

functionality, 159
Runtime

common runtime environment, 232
form fragments at, 141–142

S
Sans serif fonts, 142–144
Saving forms, 8
Scalable Vector Graphics (SVG), 177
Screen readers, for accessibility, 152
Scribble Signature feature. See Signature Scribble
Script Editor

adding form validation, 223–225
changing button color, 99
Check Syntax tool, 71–72
features of, 37–38
overview of, 5
scripting calculation of totals, 100–102

scripting progressive disclosure, 99–100
Show Events drop-down list, 50
stepping through scripts at design time, 72–73
updating calculation script to work with HTML 

forms, 207
updating change event for use in both HTML and 

PDF forms, 205–206
Script objects

adding arrays to, 62–63
adding functions to, 53–58
benefits of, 52–53
calling functions in, 58–60
creating, 53, 222–223
referencing functions, 104, 223–225
renaming, 222

Script variables, 39–40
Scripting

abbreviated references, 43–44
advanced. See Advanced scripting
benefits of, 31–32
comparing HTML and XFA forms, 183
debugging. See Debugging scripts
event documentation, 48–49
event propagation, 51–52
events and, 46–47
events in action, 50–51
FormCalc and, 34–36
fully qualified references, 42
host detection, 179
JavaScript, 36
languages supported, 33–34
optimizing performance and, 155–157
overview of, 30–31
referencing current object, 44
referencing multiple objects with same name, 45–46
referencing objects, 41–42
referencing unnamed objects, 45
Script Editor, 37–38
scriptable interactivity, 3
types of events, 47, 50
updating calculation script to work with HTML 

forms, 207
using, 32–33
variables, 38–41

Scripting, for SmartDoc exercise
button color, 99
calculation of totals, 100–102
creating and referencing script objects, 102–103
progressive disclosure, 99–100
referencing functions in script objects, 104

SDK (Software Development Kit), 235
Serif fonts, 142–144
Shortcuts, for writing references, 44
Show Events drop-down list, 223
Signature Scribble

adding to approval subform, 216–217
as alternative to digital signatures, 190
updating PDF form for HTML, 209–210
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Simple Object Access Protocol (SOAP), 235
SmartDoc Expense Report form

creating and referencing script objects, 102–103
creating body page and subforms, 89–91
creating custom object library, 86
creating data connection for, 91–93
creating dynamic subforms, 94–98
creating master pages, 88–89
creating pages and subforms, 87
overview of, 85–86
previewing dynamic subforms, 93
referencing functions in script objects, 104
scripting button color, 99
scripting calculations, 100–102
scripting progressive disclosure, 99–100
testing, 104–106
using native form app, 255–256
viewing on iPad, 253

SmartDoc Expense Report form, updating for HTML
adding dynamic signature fields, 209–210
adding host detection script, 205–206
overview of, 198–199
updating calculations, 207
updating Date field, 203–204
updating font, 199–202
updating font by editing XML source, 202–203
updating layout, 208–209
updating patterns, 206

SmartDoc Library, adding form fragments to, 140
SOAP (Simple Object Access Protocol), 235
Software Development Kit (SDK), 235
Standard Object Library, 210
Start Process, LiveCycle Workspace, 250
Static objects, master page features, 10
Static PDF forms, 147
Style sheets

changing visual aspect of HTML forms, 191–193
external, 28
internal, 26–27
mobile forms support, 169
modifying Address Change Form, 226–227
options for saving forms, 8
overview of, 26, 177
setting default, 29

Subform panel, of Object palette, 215–216
Subforms

creating dynamic, 94–98
hidden and invisible, 14–15
how they work, 12–13
previewing dynamic, 93
structure of, 11–12

Subforms, in Address Change Form
approval subform, 216–217
background subform, 211–212
business and family subforms, 214–216
dynamic subform, 220–222
individual subform, 212–214

Subforms, in SmartDoc Expense Report, 89–91
Substitution feature, Acrobat fonts, 144
SVG (Scalable Vector Graphics), 177
System strategies, for optimizing PDF forms, 159

T
Tabbing order, of forms

how it works, 75
left-side palettes for organizing forms, 6
options, 76–77
overview of, 74
Tab Order palette, 75–76

Table Assistant, 16
Table menu, 16
Tables

dynamic, 17–18
HTML forms and, 189
Table Assistant and Table menu, 16
Table objects, 15

Tablet devices, viewing PDFs, 129
Targeting

web browsers and, 185
XFA version support in Acrobat and Designer, 

132–133
Task Manager, Workbench endpoints, 237
TDS files

creating templates and, 135
options for saving forms, 8

Template Manager, 135
Template Resource Cache Settings panel, 163
Templates

creating, 134–135
options for saving forms, 8
using, 134

Testing
Address Change Form, 225
HTML forms in different browsers, 185
SmartDoc Expense Report form, 104–106

Text
balancing performance and functionality, 159
comparing layout and graphics in XFA and HTML 

forms, 180
Text Overflow Indicator, 201–202
viewing CSS elements on Address Change 

Form, 227
Text Field object, from Standard Object Library, 210
Third-party viewers

viewing PDFs on tablet devices, 129
web browsers with default viewers, 129–130

Time, localization and, 149
Time fields, in LiveCycle Designer, 23–24
To-do section, LiveCycle Workspace, 250
Troubleshooting tools, in LiveCycle Enterprise 

Suite, 233



 INDE X 267

U
Universally unique identifiers (UUIDs), 165
Use Global Data, data binding approaches, 18
Use Name, data binding approaches, 18
UUIDs (universally unique identifiers), 165

V
Validation

adding form validation, 223–225
regular expressions for, 60–61
scripts for, 31

Validation script object
creating and referencing script objects, 102–103
Hierarchy palette and, 223
referencing functions in, 104

Variables
form variables, 39–40
naming, 39
script variables, 39–40
types of, 38

Vision disability, accessibility and, 150, 153

W
Warnings tab, Report palette

Missing Required Fields warning, 225
overview of, 68–69
Target Version setting and, 132

Watched folder, Workbench endpoints, 237
Web browsers

Adobe supported, 176
default PDF viewers, 129–130
testing HTML forms in, 185
testing tables in, 189

Web services
calling, 83–84
connecting to WSDL file, 80–83
extending Reader to call, 122–123
overview of, 80
REST (Representational State Transfer) compared 

with, 194–197
Web-safe fonts, 180, 199
Widgets, customizing for HTML forms, 193–194
Windows OSs

Acrobat support, 120
browser support, 176

Workbench
creating LiveCycle process in, 194–195
development tools in LiveCycle Enterprise Suite, 

235–236

endpoints, 237
forms deployment and, 242
process management in, 248

Workspace
customizing, 24
illustration of interface, 4
Layout Editor and, 4–5
left-side palettes for organizing forms, 5–6
LiveCycle Workspace program, 249–250
Mobile Workspace app, 250–252
Process Management module and, 248
right-side palettes for creating/editing form 

objects, 7
Script Editor and, 5

WSDL file, 80–83

X
Xcode, developing iOS apps with, 252
XDP files

Master File Strategy for development and, 186
master form fragment saved as, 138
optimizing caching of resource files, 162–163
options for saving forms, 8
policy documents saved as, 188
transforming into HTML forms, 169

XDP forms, web-safe fonts for, 199
XFA (XML Forms Architecture) PDF

accessibility features, 151
Adobe Reader support, 119
comparing with HTML forms, 177
dynamic forms, 111–112
overview of, 109
static forms, 110
third-party viewers and, 129
transforming to HTML, 174–176
version support in Acrobat and Designer, 132–133

XFS files, 8
XML files

Multiple Master File Strategy for development 
and, 186

optimizing performance with, 159–161
options for saving forms, 8

XML Forms Architecture (XFA) PDF. See XFA (XML 
Forms Architecture) PDF

XML schema, binding blank form to, 21–23
XML source

changing fonts by editing, 202–203
Layout Editor tabs, 5
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